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1 Introduction

Template Builder is aweb application that allows journalists and content creators to edit and build
customized templates based on existing templates that have been generated and organized using Viz
Pilot's Template Wizard.

The templates can be customized using different functionalities described in this guide. The mgjor
functionality in Template Builder is the possibility to add custom HTML panels to templates which gives
the user full control over the template by using custom scripting and logic.

1.1 Workflow

The basic workflow from graphics design to aworking template is as follows:

® Scenesare madein Viz Artist. Multiple scenes can make up one template, categorized under
different variants.

® Objectsin the scene, that the graphics designer wants to make editable in the finished template, are
given the appropriate control plugins.

®* Templates are made in Template Wizard, after importing the scene(s) over.

® Thesetemplates are saved within the Pilot system and are available to the Template Builder.

® |n Template Builder atemplate can be opened, edited/customized and previewed.

®* Thetemplateis saved back into the Pilot system and is made available to the newsroom and control
room systems.



® A journalist, editor or other content creators, fill the graphics template with content. This can
include: text, numbers, images, videos, websites and maps. The template is saved into the Viz Pilot
system creating a data element that is added to the newsroom story.

® The Viz Pilot operator monitors the newsroom playlist (rundown) and plays the graphics on-air at the
correct time in the broadcast.

The changes made to a template in Template Builder will not be available in the template in Template
Wizard

1.2 Document Structure
This User's Guide is divided into the following chapters:
® |ntroduction

® Setup
® Using the Template Builder

1.3 Related Documents

The templates customized in Template Builder can be used by other Viz products like Viz Pilot Edge, Viz
Story and Viz Multiplay.

For more information about al of the Vizrt products, visit:

® www.vizrt.com

® Vizrt Documentation Center
® Vizrt Training Center

® Vizrt Forum

1.4 Customer Feedback and Suggestions

We encourage suggestions and feedback about our products and documentation.

To give feedback and, or suggestions, please identify your local Vizrt customer support team at www.vizrt.
com.

1. Click on Contact (top of page).

2. TheVizrt office which is nearest to your location will be shown, or select from the list of Vizrt
offices.

Click on the Contact button for the office you want.

4. Complete the required details in the window that open
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5. A Vizrt representative will contact you as soon as possible.

If this message is for Customer Support, and there is a Support Contract in place, then click on
the ‘ For support requests, please visit our support portal’ link in the message window.

1.5 Customer Support Requests

Support Requests are supported by Vizrt if customers have avalid Service Agreement in operation.
Customers who do not have a Service Agreement and would like to set up a Service Agreement should
contact their regional sales representative (see Customer Feedback and Suggestions).

When submitting a Support Request, relevant and correct information should be given to Vizrt Support, to
make sure that Vizrt Support can give the quickest and best solution to your Support Reguest.

This section contains the following topics:

® Before Submitting a Support Request
® Submitting a Support Request

1.6 Before Submitting a Support Request
Before a Support Request is submitted make sure that you:

Read:

® Therelevant User Guide or Guides
® Therelease notes
and Check:

® That the system is configured correctly
® That you have the specified hardware, tested and recommended versions
Always refer to your Vizrt Service Level Agreement document.

1.7 Submitting a Support Request

When completing a Support Request, add as much information as possible.

1.7.1 Content of a Support Request

The report should contain information about these topics:

® Problem description: Include a good description of what the problem is and how to reproduce it.
Specify your workflow. Remember to use simple English.

® Screenshotsand illustrations: Use these to simplify the message. These are extremely useful for
Vizrt Support.

® Software configuration: Add exact versions of software used. Thisis extremely important
information. The version information is available in the log.



® System log files: Send the system log file. Y ou can save your log filein the link to Logs pane.

® System locale: Specify the Region and Language settings of the system.

® Hardware configuration: Add exact versions of hardware used, especially for Viz Engine.
Optional:

® System setup: Describe differencesin the installation, if any, from the recommended setup.

® System Network: Add a description of how the network, bandwidth, routers, and switches are
configured.
Always refer to your Vizrt Service Level Agreement document.

1.7.2 To submit a Support Request:

On the www.vizrt.com page, click on Support.

Click on Report a case.

Click on LOG IN tologin to the Customer and Partner portal.

At the top of the Case Management page, click on Report a Case.

In the online form complete the required minimum information (shown by ared asterisk) and click
SAVE.

6. Inthe saved Support Case that opens, complete the various text boxes and upload any required
documents, files, etc. (see Content of a Support Request).

Totrack the status of open support tickets, login to the Customer and Partner portal. Add
information or communicate about the cases directly with the support team.

arwDdRE
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2 Setup

The Template Builder opens as aweb application in your default browser.
The URL to access Template Builder, if hosted on the Pilot Data Server, is:

http:// pds-host-nane: 8177/t enpl at ebui | der

2.1 Template Builder and Mist

To make resource sharing with other products like Viz Pilot Edge and Viz Story simpler, or if you need
https support, it is recommended to install Mist and let that serve out all the products.

The URL to access Template Builder if served out by Mist is:

htt p: // host nane/ t enpl at ebui | der/



3 Using the Template Builder

This section will explain the user interface of the Template Builder and how to useit.

In addition to a brief overview of the user interface below, the following topics are explained in more
detail:

® Template Preparation

® The Template Builder Window
® TheFill In Form

® The Preview Window

3.1 Open a Template

Template Builder isatool for editing and customizing existing templates. When started, Template Builder
will automatically open the Open Template dialog where existing templates available within the Pilot
system are listed.

In the Open Template diaog, find the desired template by selecting CONCEPT and TAGS. The
template search can be narrowed down by searching for the template name in the Typeto filter... field at
the top.

Open Template
h

CONCEPT TEMPLATES

3linesBIGCenter

(All templates)

—
—_—

linesBIGCenterMNEW
ImageFull

LowerThird

(Uncategorized)
Basic
Orange

Vibrant

3.2 Man User Interface

The main user interface is divided into three main windows.

(1) The Template Builder Window



(2) The Fll In Form
(3) The Preview Window

The Preview Window (3) provides snapshots of the graphics with content. The preview snapshots provide
the user with an idea of how the graphics will look like when played on air and are updated as changes are
being made in the Fill In Form (2). In the Fill In Form the user fills in/edits content for the graphics. The
field information, exposed fields, and layout in the Fill In Form can be customized by the user in the
Template Builder Window (1).

L Crapties Previe
Editall Show all Refresh HTML panels | Grap! =

LINE 01
LINE 02
= storylayer Lowerthird

3.3 Open

The Open button, E , islocated in the toolbar at the top of the Template Builder window. Clicking it
or pressing CTRL + O on the keyboard opens the Open Template dialog allowing opening another
existing template available within the Pilot system. If there are unsaved changes in the template that was
open before the Open button was clicked, Template Builder will ask whether these changes should be
saved before opening a new template.

3.4 Save

The save button, , islocated next to the open button. Clicking it or pressing CTRL + S savesthe
changes made to an open template in the Template Builder. The updated template will overwrite the
existing template in the Pilot Data Server.
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3.5 Restore

The restore button, , Will undo all changes since the last save.

3.6 About

Clicking the Template Builder logo _ in the top left corner of the application takes the
user to the about page.

Hereisinformation about software version, link to local documentation and link to third-party licenses.

3.7 Template Preparation

The current version of Template Builder relies on templates being generated and organized using Viz
Pilot's Template Wizard. The following procedures will give you a quick introduction on how to create
and manage atemplate. For more information on how to work with Template Wizard, please see the Viz
Pilot User's Guide.

3.7.1 Creating a Template

[Third] - SCENE*Vizrt/Scenes/VizTrio/Concept_Var...

e Save template

= £312 (Lower Third SUBTITLE)
Bz CSubtitle: oo iiiii

------------------------- o

Tag:
<MNone=

The following procedure explains how to create and save a template.

To create atemplate:

Start Template Wizard

Connect to your Viz Engine

On the File menu, select Wizard

Drag and drop the scene to the Selected Scenes pane (right)
Click Finish

On the File menu, select Save (Ctrl+S)

Enter a Template name

Select a Concept name (or create a new)

Click Save as New

©Oo N O AWNE
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3.7.2 Managing Concepts and Variants

2 | Template Manager
B conceos-a Concept templates
[NEWS Red [ || [Third {1 |
v NEWS Blue v v Lower
v vl Upper
Meaw | Edit | Delete | Mew | Edit | Delete | Mew | Edit | Delete |

The following procedures explain how to organize a template for use with more than one concept and
variant, for example a Blue and Red concept with alower and upper third graphic. As aprerequisite all
scenes should have the same type of datain order to use the same template.

To manage concepts:

On the Tools menu, select Template Manager

Under the Concepts - All pane, click New

Enter a name for the new concept and save it

Open the other concept

Drag and drop the template from the old to the new concept (and confirm the operation)
Open the new concept

Edit the template by selecting the correct Scene folder for your new concept

Save and confirm the operation

© N~ WD R

To manage variants.

On the Tools menu, select Template Manager
Select your concept, then the template

Under the Template variants pane, click New
Enter a Description of the variant

Select the Scene name that is a variant of the other
Save and confirm the operation

o0~ wWwDdNE

3.8 The Template Builder Window

The Template Builder window is located to the left in the application and is where al the customization of
the template is performed.

It consists of three windows;
® Template Settings

® Field Tree
® Field Properties

12



3.8.1 Template Settings

At the top of the Template Builder Window a Settings drop-down list is available, which alows for the
following template settings:

Duration

The duration setting can be used to specify the duration of the item. A default value is used when
unspecified. Minimum and maximum duration values may also be specified. If these are set to the same
number the item will get afixed duration.

OT LOWERTHIRD Duration

DURATION SETTINGS
Default Minimum :  Maximum :

Track

Setting aName in the track settings allows for grouping of graphicsin the timeline editor, see Track
settings displayed in the timeline editor. The Index sets the position of the group in the timeline editor,
where 0 isthe lowest position.

WARNING!

Make sure to use the same index for the same name in all modified templates

OT LOWERTHIRD

TRACK SETTINGS

Mame :

Track settings displayed in the timeline editor

The red rectangle highlights the different tracks in the timeline editor. The position of these tracksis set
using the Track setting.

13



O [GEX] POSTERS

O [GFX) WiPEs

O [GFX) LOGD

GFX| LOWERTHIRDS

O (OVERLAY]

O [MAIN]

Title generation

Thetitle generation setting allows for auto-generation of the title. Thetitle can be plain text or it can bea
placeholder for one or several field values, or it can be a combination. The placeholder isthe {Field ID}.
An example combining plain text, field name, and subfield name is shown below:

OT LOWERTHIRD Settings : | Title gener... | ¥ | =5 Default Values Editall Show all Refresh HTML panels

TITLE GENERATION SETTINGS

Field ID ‘
v
¥ _ -concept-variant-choice

4 of 22 used.

= concept

variant
11 of 33 used.

LINE 01

LINE 02

storylayer Lowerthird

A template title can be auto-generated by combining one or several of these options:

® Normal text - plain text

{Field ID} - will be substituted by the value of the field

* {Field ID/subfield ID} - will be substituted by the value of the subfield

¢ {listfieldname/#index/cellname} - will be substituted by the value of the field in arow in alist. Note
that the index is zero-based.

WARNING!

The auto-generated title does not get trimmed inside Vizrt web clients. However, if the titleislonger
than 128 characters it will be trimmed when dragging out the MOS XML file due to size constraints.
Thiswill affect the element title in the newsroom system.
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3.8.2Field Tree

Each linein the Field Tree displays the ID and the label of afield and often correspondsto afield in the
Fill Inform. It also contains an icon indicating the Type of the field.

OT LOWERTHIRD Nane

D e
Editall Show all Refresh HTML panels ® Graphics
Field ID
v -concept-variant-choice :
= concept -
4 of 22 used
= variant
01 LINE 01
_ _ 11 of 33 used.
02 LINE 02 _

= storylayer Lowerthird

OT LOWERTHIRD ==: Default Values Editall Show all Refresh HTML panels
Field ID

Concept :
v -CONCEpL-vai iani-cnoice

Variant :
d or HTML pi

V ry Landscape * Grey :
= concept
: LINE 01 4 of 22 used
= variant

Name

LINE Q2 :

01 LINE 01
11 of 33 used
= 02 Li v

Designation
= storylayer Lowerthird

Thelisting of Fields can be rearranged by drag-and-drop within the Field tree.

Right-clicking aField, alist of choices appears. From here Fields and HTML panels can be added.

The Fill In Form will alwaysimmediately update upon any change.
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OT UPPER THIRD
Field ID
Y _ -concept-variant-choice
concept
variant
LINE 01

I INE 02
Add field before ¥ arthird

Add field after b
Add child field b

Add HTML panel before
Add HTML panel after

Multi-selection

It is possible to multi-select in the Field Tree. After selecting the first field of interest, more fields may be
selected by CTRL + click. It is not possible to move or rename multiple fields at the same time, but
multiple fields may be deleted and some of their properties may also be changed by making changesin the
Field Properties window.

3.8.3 Field Properties

The Field Properties window islocated below the Field Tree window. It displays the properties of the
field(s) selected in the Field Tree.

® Multi-selection - If several fields are selected in the Field Tree, a subset of the field properties for

the selected fields are displayed. If the selected fields have different field property values, the Field
Properties window displays a multiple values state. Changes made in the Field Properties window
areimmediately applied to all the selected fields.

j Muliple fields
A Readonly

Hidden

® Single-selection - All properties for the selected field are displayed. Note that the set of properties
depend on the type of the field.
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Label :
Omo
Tip:
omo

Read-only

Hidden

Maximurm -

Data entry :

Label
Specifies the label of the field in the Fill In Form.

Tip text

A tooltip text can be entered to give more information about the field.

Read-only
Selecting the Read-only checkbox will keep the field visible, but grayed out in the Fill In Form.

Hidden
Selecting the Hidden checkbox will hide the field in the Fill In Form.

Type
The type of content allowed in the field in the Fill In Form are set using the drop-down list under Type.
Depending on the type selected different sub-choices become available which is specified in the table
below.

There are two main field type categories, scalar and list. Fields with all types except thelist type are
referred to as scalar fields. Fields using the list type are referred to as list fields.

The following types are available;

Type Icon Description

Empty .

17



Type

Icon

Description

Will make the field unavailable.
Typically used as a container for
other fields.

Plain text

Thefield isatext field.

Max length: Set the number of
maximum charactersin the field.

Normalized text

Normalized text.

Max length: Set the number of
maximum charactersin the field.

Formatted text

A text that allows formatting.

Max length: Set the number of
maximum charactersin the field.

Single-line: Check this box to
specify that the rich-text editor
should only alow oneline of text.

Boolean

Creates a checkbox which have two
states; true and false.

Integer

Thefield isaninteger field.

Minimum: Set the minimum value
allowed.

Maximum: Set the maximum value
allowed.

Decima

The field allows decimal numbers.

Minimum: Set the minimum value
alowed.

Maximum: Set the maximum value
allowed.

Date and time

Use the Date Chooser inthe Fill In
Form to select date and time in this
field.

Two numbers (duplet)

£l

Thefield allows two numbers
(decimal numbers are allowed).

Minimum: Set the minimum value
allowed for both numbers.

Maximum: Set the maximum value
alowed for both numbers.

18



Type

Icon

Description

Three numbers (triplet)

Thefield allows three numbers
(decimal numbers are allowed).

Minimum: Set the minimum value
allowed for all three numbers.

Maximum: Set the maximum value
alowed for all three numbers.

Image E Will make the field available for an
image.

Video Will make thefield available for a
video.

Font Will make the field available for a
font.

Geometry m Will make the field available for a
geometry.

Material i) Will make the field available for a
material.

Map Will make the field available to
present and edit a map.

Custom H Using the custom type the media-
and X SD- type can be freely
specified.

List m Lists may be modified by adding

and removing columnsin the Field
Tree. To add columnsto aligt, right-
click the columns node under the list
field node in the Field Tree and
select Add column. To remove a
column, select the column field in
the Field Tree and press the Delete
button, or right-click it and select
Deletefield.

List fields are fundamentally
different from scalar fields. It is
therefore not possible to change a
list typeto ascalar type and vice
versa.

Minimum number of rows: This
field property defines the minimum
allowed number of rowsin thelist.

19



Type Icon Description

Maximum number of rows; This
field property defines the maximum
allowed number of rowsin thelist.

The user must be aware of available control pluginsin the template that have been exposed by the
scene designer in Viz Artist.

Data Entry

There isa Data entry drop-down list available for all scalar field types. There are three choicesin this drop-
down list, namely Manual, Choose from list and Enable feed browser.

Manual does not open up to any additional settings for the field.
Choose from list allows the template designer to present the right content in a drop-down list.

Enable feed browser allows the user to browse for an entry.

Default search parameters

For the types Image, Video, Font, Geometry, and Material it is possible to define default search
parameters that will be used by the media search that is launched when the user clicks on the field.

To define the search parameters for afield, click the Set button to open a media search window.

Set the search parameters by writing something in the search field, selecting whether to show all items or
to limit by time from the Show drop-down list, and/or selecting atag from the Tags drop-down.

Save by clicking Use current search parameters.

20



Configure default search parameters

Q

= Show :' All items

M Image

A Test-tif tif

F <
-’2_,.. "r__ 4 ¥
o -

N
M Test-tif-2TIF - M Test-png.png = MTest-jpgjpg M Testjpgips

- -
"g...
o

M Test-tif tif M Test-tif-2TIF || M Test-jpgjpg M Test-uf.uf

f: =
i ; ! T
] B e
N Y egm

M Test-tif-2TIF |~ M Test-tif tif M Test-png.png M Test-tif tif M Test-jpg.jpg

F
i

M Tecr 1if 2 TIF M 748ANQT774 M 248A0Q774 M 248ANOT74 M 248ANA774
Showing 142 of 142 results.

Use current search parameters

3.8.4 Data Entry

The Data Entry field property specifies how the user should fill in the field value. The property can take
three values which are explained below:

® Manual
® Choose from list
® Enable feed browser/Parent feed browser

Manua

Selecting Manual in the Data entry drop-down list does not give access to any additional settings for the
field.

Choose from list
Selecting Choose from list allows the template designer to present the content in a drop-down list. This
functionality may in some cases make it easier and less error-prone to fill the template with the right
content.

One example where the Choose from list functionality can be useful is when a Control Object moving
(Omo) plugin is accessible in the template. Scenes using Omo plugins will originally be presented as
integer values for the different elementsin the Fill In Form. The Choose from list option can assign text
to these values to make it easier to select the right element.

An example of how this can be done is shown below.
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In this example, there is a scene that can be displayed at the top, in the middle or at the bottom in the
graphics. For the Omo plugin, these positions correspond to the values 0, 1 and 2 respectively. To assign

text to these values, do the following:

Mark the Omo Field ID in the Field Tree.
Select the Choose from list option in the Data entry drop-down list.
® When clicking on the Alter natives button, a new window appears. Right-click to design the table by

inserting or removing rows. Click in a selected row or press F2 to do inline edits.

default =¥ Insert row above

Read-only 5, Insert row below

Higaen

Mirirmum :

Maxirnum :

® Double-click the table or press Return to insert Name, Tip, and Value. Click Next, tab or Ctrl +
down, to continue filling the table.

#2 of Alterna

Previous

® |n thetable below the values now correspond to text. Exit the table when it isfilled out

22



Tip Value
Graphics dispalyed at the top 0

Center Graphics displayed at the center 1

Bottom Graphics dispalyed at the bottom 2

® The Omo field in the Fill In Form now contains a drop-down list containing the alternatives created
above astext, as opposed to an integer field where the user would have to remember which integer
corresponds to which position.

Default Values Editall Showa

Concept : Variant :

11 of 33 used.

Use Sub-Choices

Selecting the Choose from list option, a checkbox is made available called Use sub-choices. This
functionality allows the set-up of several sub-choices for each choice.

For example, if the choices list different countries, sub-choices could list citiesin each of the countries.
See example below:

® Mark the desired Field ID in the Field Tree.

® Select Choose from list and tick the Use sub-choices check box.

® When clicking on the Alter natives button, a new window appears. Right-click to insert or remove
rows.

23



t ]

Sub Alternatives

Read-only

default
Higaen
Insert row below

L4

Minirmum :

Maxirnurm :

® Double-click the table to insert Name, Tip and Sub-choice L abel which in this caseis Cities.

Edit table row
Mext

e China/Cities

® (Click the Sub Alternatives button to add the sub-alternatives.

24



Editing List- Sub Alternatives

Edit table row Name Tip

Mext Shanghai
Beijing

Guangzhou

® EXxit the tables when they arefilled out.
® |nstead of atext field in the Fill In Form, the field now contains two drop-down lists; the main
choices, which in this caseisalist of countries, and sub-choices with corresponding cities.

A= o b v e
ic=i Default Values Editall Showa

Variant
| andscape Grey s
LINEDT 4 of 22 used.
Mame

LINE 02 - 11 of 33 used.

Lowerthird :

China

Enable feed browser/Parent feed browser

This option specifies that the field should get its value from some property of an atom feed entry. If the
field isasubfield of another field that has enabled feed browser, the option will be named Parent feed
browser. Otherwise, it will be named Enable feed browser.

25



If the Enable feed browser option is selected, a Browse button will appear next to the field in the fill-in
form. Clicking this button will open the Feed Browser dialog. In the Feed Browser, the atom entries of
the feed will be presented (with thumbnails if available), and one of the entries can be selected.
Information from the selected atom entry will be used to fill in the feed browser enabling field and its
subfields.

In order to be able to fill in multiple fields from a single selection in the feed browser, those fields
must be subfields of the field enabling the feed browser.

Atom feed URL
Thisfield property is available only for feed browser enabling fields (not for fields using parent feed
browser). The property specifiesthe URL of the atom feed that should be used to fill in the value of this
field and a selection of its subfields.

Data entry :
Enable feed browser

Atom Feed URL :

Select from atom entry :

Select from atom entry
Thisfield property specifies which information in the atom entry selected in the Feed Browser that should
be used to fill in thisfield. The following options are available, but the possible options for a given field
depend on the type of the field (the atom namespace prefix represents the http: //www.w3.0rg/2005/Atom
namespace, and the media namespace represents the http://search.yahoo.comymrss/ namespace):
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7 Summary

Enable feed browse

Atom Feed LURL:

Select from atom entry:

ot linkeds

Content

Thumbna

<Not linked> — Thefield is not linked to the atom feed, and must be filled in manually.

Content — Thefield islinked to the content of the at om cont ent element in the atom entry.
Title—Thefield islinked to the content of theat om ti t | e element in the atom entry.

Link —Thefieldislinked to the hr ef attribute of theat om | i nk element in the atom entry.
Which link entry to pick depends on the Link-rel in atom entry property and the type of the field.
(Thefirst link with a correct rel attribute and a type that matches the type of the field will be chosen.)
Entry — Thefield islinked to atom entry itself.

Author name —The field islinked to the content of the at om nane element inside the relevant
at om aut hor element. (If the entry itself containsan at om aut hor element, that will be used.
Otherwisethe at om aut hor element of the feed itself will be used.)

Author e-mail — Thefield islinked to the content of the at om enai | element inside the relevant
at om aut hor element. (If the entry itself containsan at om aut hor element, that will be used.
Otherwisethe at om aut hor element of the feed itself will be used.)

Author URI —Thefield islinked to the content of the at om ur i element inside the relevant

at om aut hor element. (If the entry itself containsan at om aut hor element, that will be used.
Otherwisethe at om aut hor element of the feed itself will be used.)

Contributor name — Thefield islinked to the content of the at om nane element inside the at om
cont ri but or element in the atom entry.

Published — Thefield islinked to the content of the at om publ i shed element in the atom entry.
Updated — Thefield islinked to the content of the at om updat ed element in the atom entry.
Thumbnail — Thefield islinked to theur | attribute of the medi a: t hunbnai | element in the
atom entry.

Summary — Thefield islinked to the content of the at om sunmar y element in the atom entry.
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Link-rel in atom entry

This property isonly available if Link is selected in the Select from atom entry property. It specifies what
ther el attribute of the link element in the atom entry should be.

3.85TheHTML Panel

As apart of the customization workflow, the user can add an HTML panel to the template, whichisa
functionality that gives the user full control over the template by using custom scripting and logic to build
the template. The template can host a webpage by entering aweb addressin the Template Builder.
Normally the aim is not to host a single webpage, but rather make a data integration HTML template.

A simple example showing how to connect a custom HTML template to a pilot template is shown below.
Keep in mind that this example shows a limited possibility of what can be done using the customized
workflow. Using it in more advanced ways opens up to possibilities where the user has 100% control over
the template.

Add HTML panel

The option of adding an HTML panel is available by right-clicking in thefield ID list in the Template
Builder window. Selecting the HTML panel field ID, its properties become available in the bottom
window.

Adjust the size of the HTML panel shown in the Fill In Form using the Height field.
In the Source URL typein the web address.

The Hidden fields drop-down list allows the user to hide available fields in the Fill In Form.

Custom HTML template

Using the custom HTML template opens up to full user control of the template using custom scripting and
custom logic.

The following example will show how to create a simple custom HTML template in Template Builder.

In this example we are working with a simple custom HTML template showing the message Hello world
when opened in a browser:
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[Annette} - O %
5 Custom HTML Template X

< C ‘ 0 pilotdataserver:3177/app/mytemplates/customTemplate_sample.html ‘ B O

Hello world

How to seethe custom HTML template inside Template Builder

® Open atemplatein Template Builder and add an HTML panel to the template as explained above
® |nthe URL field enter the URL of the custom HTML template
® Now the message Hello world should appear in the Fill In Form:

Editall Showall Refresh HTML panels

riant-choice L

11 of 33 used.
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How to connect the cussom HTML templateto the pilot template

Following the example above, it is how ready to establish atwo-way communication, or bind fields,
between the HTML template and the opened pilot template. A new field is therefore added to the
template:

® Right-click on your HTML panel field, and choose Add field after
® Giveittheid 50

® Changethefieldstypeto Plain text

® A new field appears:

Editall Showall Refresh HTML panels

50
Label :

Tip text

Read-only -

Hidden -

Limit with choice :

To connect the custom HTML template to the newly created field, the custom HTML template is opened
in an editor.

The payloadhosting.js file must be included in the HTML template. Thisfileislocated in the jsfolder in
the template builder folder.

The entire <body> block is replaced with:
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<body onl oad="vi zrt. payl oadhosting.initialize()">
<l abel for="field 50">My input field:</label>
<i nput nanme="field 50" type="text" id="field 50">
</ body>

Saving the HTML file and clicking Refresh HTML panels, rel oads the custom HTML template with the
changes just made. Now a bi-directional connection between the editor and the custom template have been
established. When typing either inside the template or inside the field with id 50, both fields should be
updated at the same time. Thisway of binding fields will work for any HTML fields that have value
support, whichistypically <i nput > typesand <t ext ar ea>.

OT LOWERTHIRD Set : Default Values Show all Refresh HTML panels

-concept-variant-choice
concept
variant LINED1 -
o LINE 01 Nan
- HNEEE 11 of 33 used.

storylayer Lowerthird

99

=5 The custom template is upda

omTemplate_sample.htm

Addingthe i d="fi el d_50" tothe <input>element insidethe HTML templateisall that is needed for
the two-way communication to be set up since we added afield with theid of 50. Any amount of these
binding fields can be established the exact same way; the way they are mapped are viaid.

This gives asimple way of setting up abinding field. Note that updating the <i nput > elements
programmatically will still send data back and forth; which is great for automated data integration such as
fetching live sports data.

To prevent two editors for the same field being visible at the same time, use the Hidden fields setting
inside the HTML panel settings.
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Browser Caching

The user might experience browser caching behavior when trying to update and display changesin the
custom HTML template in Template Builder. Thisis standard browser behavior and Template Builder
does not have control over caching resources that the HTML fileitself includes.

To prevent this browser behavior, following actions can be made:

1. Make surethe URL's to the resources are unique upon reload.

2. The web server serving the resources could be configured to send Expiry headers set to 0. More
detailed information on how caching works and how to modify these is out of scope for this
documentation

3. Disable caching on the browser side. Thisis done differently per browser.

3.9 The Fill In Form

The window in the middle of the Template Builder application is the auto-generated fill in form for the
graphics template. It displays the default valuesin the template which are editable fields where the user
can add content. The types of content allowed in the fields are controlled in the Template Builder Window
. Fields can be restricted to contain e.g. only text with a certain amount of characters, numbers within a
specific range, media placeholders for media assets, or it can be a set of choicesin adrop-down list.

Aslong asthefieldsin the Fill In Form are exposed controls made by the template designer, the added
content will be shown in the Preview Window .

Default Values Editall Showall Refresh HTML panels

.
v

4 of 30 used.

Limit with choice :
Top

Mo Image set

At the top of the Fill In Form there are three options Edit all, Show all and Refresh HTML panels.
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Edit all isan option to edit all fieldsin the Fill In Form. Thisisto provide away to edit default values of
fields that are set to read-only.

Selecting Show all displays all fieldsin the Fill In Form, even if the fields are set in hidden mode.

Selecting Refresh HTML panelswill reload the HTML panel(s) in the Fill In Form.

3.10 The Preview Window

The Graphics Preview window is located to the right in the Template Builder. It displays snapshots of the
fina output in an ongoing preview process, and provides you with an idea about how the graphics will
look when played out in high resolution on aViz Engine.

The Template Builder sends requests to the Preview Server which manages Viz Engines that provides the
snapshots.

T . . .
™ Graphics Preview

place

Text here

place3 TA SA K | Auto-refresh : . Load

{« <« p >

00:07 00:02 00:03 00:04 00:05 00:06 0007

?

Thetoolbar at the bottom of the Preview Window allows you to adjust how to view the preview of the
element graphics:

33



® Preview points: If the scene contains named preview points, such as stop points and/or tagsin the
Default director, these are shown as buttons on the toolbar. If there is not enough space for the
buttons, they appear in a drop-down list instead. Pressing the buttons or selecting an entry from the
drop-down list shows a preview of the scene at the given preview point, and the CTI on the timeline
jumpsto the point in time where the preview point is set.

® TA: Show/hidethe Title Area.

® SA: Show/hide the Safe Area.

® K: Show the key signal for the graphics.

® | oad: Clicking this button will load the animation of the graphics. Once loaded, indicated by a green
line at the bottom of the timeline editor, media controls appear alowing for controlling the graphics
animation in the Preview Window.

® Scrub the timeline back and forth by clicking on it or moving the CTI. If the scene does not have a
director called Default, or the Default director does not have a duration the timeline will be disabled.
Setting the minimum duration in Template Builder will enable the timeline. Setting the default
duration in Template Builder will change the duration of the timeline if it is enabled.

Clicking on a preview point to request a preview sends a snapshot request with a named position
to the Preview Server. Clicking on the timeline sends a snapshot request with an absolute
position to the Preview Server.

For further details, refer to the documentation for the Preview Server REST API.

3.10.1 Auto-refresh

Auto-refresh islocated at the bottom of the Preview Window and is on by default. This means that the
Preview Window updates immediately on any changes in the Properties Editor.

Click the checkbox to turn off Auto-refresh. To refresh the Preview Window in this mode, click the

(3 Autorefresh : |:|

Refresh button or click inside the Preview Window.
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